Department Administrator

Student Guide
# Table of Contents

## Navigating Oracle Applications

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objectives</td>
<td>1-1</td>
</tr>
<tr>
<td>Installing the SUN Java Plug-In</td>
<td>1-3</td>
</tr>
<tr>
<td>Logging on to the PRISM System</td>
<td>1-5</td>
</tr>
<tr>
<td>PRISM Home Page</td>
<td>1-7</td>
</tr>
<tr>
<td>Basic Navigation</td>
<td>1-9</td>
</tr>
<tr>
<td>Navigation Top-Ten List</td>
<td>1-11</td>
</tr>
<tr>
<td>Using the Applications Toolbar</td>
<td>1-14</td>
</tr>
<tr>
<td>Using Keyboard Shortcuts</td>
<td>1-17</td>
</tr>
<tr>
<td>Window Navigation</td>
<td>1-18</td>
</tr>
<tr>
<td>Navigating in Oracle General Ledger</td>
<td>1-19</td>
</tr>
<tr>
<td>Switching Responsibilities</td>
<td>1-22</td>
</tr>
<tr>
<td>Exiting Oracle Applications</td>
<td>1-23</td>
</tr>
</tbody>
</table>

## Manual Journal Entries

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Journal Entries</td>
<td>2-1</td>
</tr>
<tr>
<td>Journal Batches</td>
<td>2-2</td>
</tr>
<tr>
<td>Creating Manual Journal Entries</td>
<td>2-4</td>
</tr>
<tr>
<td>Lab 1: Entering a Non-Salary Cost Transfer</td>
<td>2-16</td>
</tr>
<tr>
<td>Lab 1 Solutions: Entering a Non-Salary Cost Transfer</td>
<td>2-17</td>
</tr>
<tr>
<td>Lab 2: Entering a Multi-Entity Journal Entry</td>
<td>2-19</td>
</tr>
<tr>
<td>Lab 2 Solutions: Entering a Multi-Entity Journal</td>
<td>2-20</td>
</tr>
<tr>
<td>Lab 3: Entering a Multi-Department Journal</td>
<td>2-23</td>
</tr>
<tr>
<td>Lab 3 Solutions: Entering a Multi-Department Journal</td>
<td>2-24</td>
</tr>
<tr>
<td>Modifying/Deleting Journal Entries – Inserting a Record</td>
<td>2-26</td>
</tr>
<tr>
<td>Modifying/Deleting Journal Entries – Changing a Batch Period</td>
<td>2-30</td>
</tr>
<tr>
<td>Modifying/Deleting Journal Entries – Deleting a Batch</td>
<td>2-33</td>
</tr>
</tbody>
</table>

## Journal Entry Inquiry

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal Entry Inquiry</td>
<td>3-1</td>
</tr>
<tr>
<td>Journal Entry Inquiry – Inserting a Record</td>
<td>3-2</td>
</tr>
<tr>
<td>Lab 4: Journal Entry Inquiry</td>
<td>3-4</td>
</tr>
<tr>
<td>Lab 4: Solutions: Journal Entry Inquiry</td>
<td>3-10</td>
</tr>
<tr>
<td>Lab 5: Account Inquiry</td>
<td>4-1</td>
</tr>
</tbody>
</table>

## Account Inquiry

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Inquiry</td>
<td>4-2</td>
</tr>
<tr>
<td>Lab 5: Account Inquiry</td>
<td>4-4</td>
</tr>
<tr>
<td>Lab 5 Solutions: Account Inquiry</td>
<td>4-18</td>
</tr>
<tr>
<td>Lab 5 Solutions: Account Inquiry</td>
<td>4-19</td>
</tr>
</tbody>
</table>
# Table of Contents

**Viewing Funds Available**
- Viewing Funds Available ................................................................. 5-1
- Viewing Funds Available ................................................................. 5-2
- Funds Available Inquiry Drilldown ..................................................... 5-4
- Lab 6: View Funds Available ......................................................... 5-12
- Lab 6 Solutions: View Funds Available ......................................... 5-13

**Running Oracle Reports**
- Running Oracle Reports ................................................................. 6-1
- GL Standard Reports ................................................................. 6-3
- Run Standard Reports ................................................................. 6-7
- View Reports Online ................................................................. 6-12
- Print a Hardcopy of a Report ...................................................... 6-13
- Reprint Option ................................................................. 6-14
- Copy Output to another Application ........................................... 6-17
- Cancel a Print Request ................................................................. 6-19
- Run FSG Reports ................................................................. 6-20
- Lab 7: Run Standard Reports ......................................................... 6-23
- Lab 7 Solutions: Run Standard Reports ........................................... 6-24

**Miscellaneous Information**
- Chief Financial Officer website ..................................................... 7-2
- PRISM Website ................................................................. 7-4
- Printer Profile ................................................................. 7-8
Navigation

Chapter 1
Navigation

Section Objectives

At the end of this section, you should be able to:

- Log on to the PRISM applications
- Choose a Responsibility
- Use the Oracle Applications *Home Page & Navigator* window
- Create a *Navigation Top-Ten List*
- Navigate within Oracle Applications windows
- Use the Oracle Application Toolbar, Menu items and Shortcut Keys
- Switch Responsibilities
- Exit Oracle Applications
Installing the SUN Java Plug-in

Install the SUN Java Plug-in

- You must have the SUN Java Plug-in installed on your computer before you can use PRISM.
- This procedure needs to be done only once, and that is the first time you log on to PRISM.
- Unless you have full administrative rights to your computer, you must have someone from your tech support group install the Plug-in.

Follow the steps listed below to get directions for installing the Sun Java Plug-in.

1. Double-click on the Internet Explorer icon

2. Enter the following URL:
   
   http://www.cfo.pitt.edu

3. Click on the PRISM link found under CFO Resources
4. Click on SUN Java Plug-in Installation Instructions under User Access to get the instructions for installing the plug-in.
Logging On to the PRISM System

Log On to the PRISM System

University Portal
Sign On
   Enter User Name
   Enter Password
B → Log In
   PRISM Community

1. Navigate to the University Portal (https://my.pitt.edu)

2. Enter Username and Password
   - If you have forgotten your password, click Forgot Password? to go to the University Self Service Password Reset option or contact the Technology Help Desk at 412-624-HELP (4357).
   - In order to use the self service password reset, users must setup the designated security questions at http://accounts.pitt.edu/

3. Click the Log In button
Logging On to the PRISM System

4. Click the PRISM Login link
5. The PRISM Home Page displays

6. The Worklist area will be empty the first time you log in to PRISM. Once you create documents in the Purchasing application and they are approved (or rejected), they will display in the Worklist. The Worklist is not used in the General Ledger application.

7. Your PRISM responsibilities are listed in the left-hand column under Main Menu. Notice each responsibility has a folder icon.
9. Click on the plus signs to expand the folders and see the forms associated with that responsibility.

10. Items that are expanded are preceded by a minus sign (−). You can expand no further when an item displays neither a plus or minus sign.

11. To open a form click on the form name, e.g., Enter Journals.

12. At this point you would normally start working. However, for training purposes we will return to the Navigator window (Close Form, ☐).
Basic Navigation

The Navigation List

- The navigation list is organized much like the hierarchy of a file system. You can expand items that begin with a plus sign (+) to further sublevels until you find the desired item. Sublevels appear indented below the items from which they are expanded.

- Items that are expanded are preceded by a minus sign (-). You can expand no further when an item displays neither a plus nor minus sign.

Expanding the Navigation List

Choose one of the following methods to expand an item to its next sublevel:

- Double-click the item.

- Select the item, then click the Open button shown here.

- Select the item, then click the Expand button shown here.

Collapsing the Navigation List

To collapse an expanded item:

- Select the item, then click the Collapse button shown here.
Basic Navigation

Expand and Collapse Several Items on the Navigation List
To expand or collapse several items at once, choose one of the following buttons:

- *Expand Branch* expands all the sublevels of the currently selected item.

- *Expand All* expands all the sublevels of all expandable items in the navigation list.

- *Collapse All* collapses all currently expanded items in the navigation list.

Opening a Window from the Navigation List
There are several ways to open windows from the navigation list.

1. Select the desired item, then click the *Open* button.
2. Double-click on the desired item.
3. Press the number that precedes the desired item.
**Navigation Top-Ten List**

Creating a Navigation Top-Ten List

- If there are forms that you use frequently, you can copy them to a *Navigation Top-Ten List* located on the right side of the Navigator window.

- The *Navigation Top-Ten List* displays your forms numerically so that you can choose them instantly without having to search for them in the navigation list.

- Once the *Top-Ten List* is created, it will always be displayed when you go into the Navigator window.

- You can place a maximum of ten items on the *Top-Ten List*.

- You can create a different *Top-Ten List* for each responsibility to which you have access.

- A form can be deleted from the *Top-Ten List* at any time, simply by highlighting the item and then clicking on the *Remove* button.

- A *Top-Ten List* is unique for the responsibility and user sign-on combination that you use.
Creating a Navigation Top-Ten List

1. Click the Expand All button (double plus sign)

2. Select a frequently used form from the navigation list (on the left) for the Navigation Top-Ten List by clicking once on the desired form. The form chosen must be at the lowest expanded level of the menu. Do not open the form.

   - Select Enter Journals

3. Click the button. The form is now displayed in the Navigation Top-Ten List preceded by a Top-Ten List number.
Creating a Navigation Top-Ten List

4. Add the following forms to your *Top-Ten List*.
   - Enter Journals
   - Account Inquiry
   - Journal Entry Inquiry
   - Funds Available Inquiry
   - Requests: Submit
   - Concurrent Requests: View All

5. If you want to remove a form from the *Top-Ten List*, select that form and click on the button.

Opening a Form from the Navigation Top-Ten List

6. Select the desired form in one of the following ways
   - Double-click on the form name
   - Highlight the name of the form, then click the *Open* button
   - Type the number in front of the form name
Using the Applications Toolbar

The Applications Toolbar

The toolbar:

- Is a collection of iconic buttons.
- Is a list of shortcuts that replicate many commonly used menu items so you can invoke their actions quickly without having to search for them in the menu bar.
- Is found at the top of your screen.

Each toolbar button performs a specific action. The chart listed on the next page provides the following information for each button on the toolbar:

- Icon / Button
- Action
- Meaning
- Corresponding Menu Path, enclosed in parentheses either beside or below the meaning.
Using the Applications Toolbar

- **New Record**: Opens a new record in the active form
  
  *(File → New)*

- **Find**: Opens a search window
  
  *(View → Find)*

- **Show Navigator**: Returns to the Navigator window
  
  *(View → Show Navigator)*

- **Save**: Saves any pending changes in the active form
  
  *(File → Save)*

- **Next Step**: *This feature does not work in this application*

- **Switch Responsibility**: Allows user to choose another responsibility when in the Navigator window
  
  *(File → Switch Responsibility)*

- **Print**: Prints a copy of the active window
  
  *(File → Print)*

- **Close Form**: Closes all windows in the active form
  
  *(File → Close Form)*

- **Cut**: Removes the current selection and places it on the clipboard
  
  *(Edit → Cut)*

- **Copy**: Copies the current selection to the clipboard
  
  *(Edit → Copy)*

- **Paste**: Pastes from the clipboard into a specified field
  
  *(Edit → Paste)*

- **Clear Record**: Erases the current record from the active window
  
  *(Edit → Clear → Record)*

- **Delete**: Deletes the current record from the database
  
  *(Edit → Delete)*

- **Edit Field**: Displays the Editor window for the current field
  
  *(Edit → Edit Field)*

- **Zoom**: *This feature does not work in this application*
Using the Applications Toolbar (cont’d)

- **Translations**: *This feature does not work in this application*
- **Attachments**: Opens the Attachments window
  
  (View → Attachments)
- **Folder Tools**: Enables tools for folder adjustments
  
  (Folder → etc)
- **Window Help**: Displays general help for the active window
  
  (Help → Window Help)
Using Keyboard Shortcuts

Keyboard Shortcuts

- Everything that can be done with the mouse can also be done with the keyboard.
- The keyboard shortcuts are shown in the following table:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4</td>
<td>Close Window</td>
<td>Ctrl S</td>
<td>Save</td>
</tr>
<tr>
<td>F5</td>
<td>Clear Field</td>
<td>Ctrl Down</td>
<td>Insert Record</td>
</tr>
<tr>
<td>F6</td>
<td>Clear Record</td>
<td>Ctrl Up</td>
<td>Delete Record</td>
</tr>
<tr>
<td>F8</td>
<td>Clear Form</td>
<td>Tab</td>
<td>Go to next field</td>
</tr>
<tr>
<td>F11</td>
<td>Enter Query</td>
<td>Shift Tab</td>
<td>Go to previous field</td>
</tr>
<tr>
<td>Ctrl/F11</td>
<td>Execute Query</td>
<td>Shift PageUp</td>
<td>Previous Block</td>
</tr>
<tr>
<td>F4</td>
<td>Cancel Query or Close Window</td>
<td>Shift F5</td>
<td>Duplicate Field Above</td>
</tr>
<tr>
<td>Ctrl E</td>
<td>Field Edit</td>
<td>Shift F6</td>
<td>Duplicate Record Above</td>
</tr>
<tr>
<td>Ctrl K</td>
<td>List of Keys</td>
<td>Shift Home</td>
<td>Highlight Field</td>
</tr>
<tr>
<td>Ctrl L</td>
<td>List of Values (LOV)</td>
<td>Shift End</td>
<td>Highlight Field</td>
</tr>
</tbody>
</table>

Button Shortcuts

- Each button has a descriptive name displayed inside it with a specific letter underlined. To simulate clicking the button by using the keyboard, press the Alt key and the underlined letter found inside the button. For example:

  Alt O = Open
Window Navigation

Navigating Within a Window

You can navigate within a window using one of the following methods:

- Move the cursor with your mouse.
- Choose an appropriate menu item.
- Enter an appropriate keyboard shortcut. For example, pressing Tab or Enter.

Difference between Tab and Enter

- Tab moves you between fields.
- Enter accepts the default entry in the field or window, providing there is a default available.
- If you use Enter to navigate between fields you may get unexpected errors. Use Tab or your mouse as much as possible.

Closing a Window

- In some forms, the initial window contains buttons that cause additional windows to be displayed. There are two ways to close windows within the applications.

  1. Select File from the menu bar, then select Close Form.

  2. Click the Close Window button that appears at the upper right hand corner of each active window.

  3. Use the Keyboard shortcut-- F4.

  4. Use the Close Form icon.
Navigating in Oracle General Ledger

Use the Journal Entry Inquiry form to practice navigating

1. Navigate to the Find Journals form

Oracle Application
N → Inquiry → Journals
Find Journals

2. Enter Batch.
   - IDC%CAL%

3. Enter Period.
   - Dec-15

4. Click the Find button.
5. How many batches did you retrieve?

6. For what types of charges, are the IDC journals?

7. Click on **Review Batch** for the first batch.
   - What is the **Posting** status of the batch?

8. Click on **Review Journal**.
Navigating in Oracle General Ledger

9. Use the vertical or horizontal scroll bars to move down or across the Journal Entry lines.

10. Click in the Description field for line 40. What information is being recorded in the description field?

11. Click in the Account field for line 40. What department is associated with #49201?

12. Click in the flexfield [ ] to the right of the Control Total field to determine who prepared and who authorized the journal entry.

13. Click on OK.

14. Click on File, Close Form to return to the Navigator window.
Switching Responsibilities

If you have several responsibilities and you want to work in Oracle Applications under a different responsibility, you can do so without exiting Oracle Applications. You must be in the Navigator window to switch responsibilities.

To switch your responsibility:

- Click on the Top Hat icon or select File → Switch Responsibility

- Select a new responsibility from the Responsibilities window and click the OK button or double click on the desired responsibility.

The Navigator window title and contents will reflect the new responsibility you have chosen.
Exiting Oracle Applications


2. When exiting, if changes were made and not saved, a Decision box is displayed giving you the following choices:
   - **Save →** Save the changes before exiting
   - **Cancel →** Close this window and cancel the exit
   - **Discard →** Exit without saving any changes

3. If there are no changes to save in your window or windows, a Caution pop-up box appears.

4. Click **OK** if you are certain you want to exit, otherwise click on the **Cancel** button.

5. Close all remaining windows until you return to the desktop.
Manual Journal Entries

Chapter 2
Manual Journal Entries

Section Objectives

At the end of this section, you should be able to:

- Create manual journal entries
- Review existing journal entries
- Modify existing journal entries
- Handle unusual journal entry situations
## Journal Components

<table>
<thead>
<tr>
<th>Journal Entry Batch</th>
<th>Journal Entry Header</th>
<th>Journal Entry Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Name</td>
<td>Journal Name</td>
<td>Line Number</td>
</tr>
<tr>
<td>Batch Period</td>
<td>Journal Category</td>
<td>Account</td>
</tr>
<tr>
<td>Batch Control Total</td>
<td>Journal Description</td>
<td>Debit Lines</td>
</tr>
<tr>
<td></td>
<td>Journal Control Total</td>
<td>Credit Lines</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GL_JE_BATCHES</th>
<th>GL_JE_HEADERS</th>
<th>GL_JE_LINES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Journal Batches

All manual journal entries are entered into the PRISM system by means of batches.

Journal Batches

- The use of journal batches is required.

- Batches can contain an unlimited number of journal entries.

- All journal entries in a batch must share the same period and the same category.

Batch Name

- Each batch within an accounting period must have a unique name that conforms to the established batch naming conventions.

Batch Period

- The batch period field defaults to the latest open period.

- A batch can be created for any open or future-enterable period.

- An existing batch can also be updated for any open or future-enterable period as long as the batch is not posted.

- All journals in a batch must be within the same period.
Journal Batches

Batch Control Total

- University policy requires that the Batch Control Total be entered.
- The Batch Control Total equals all debits for a batch.
- Oracle General Ledger verifies that the Control Total equals the entered debit total and that the debit total equals the credit total.
- If there is a discrepancy, Oracle General Ledger displays a warning message before saving.
- Use of the Control Total will prevent posting of a journal entry until debits and credits equal the Control Total or while a journal is in progress.
- A Control Total = 1 can be used as a flag to indicate the batch is not to be posted.

Modification/Deletion

- Batches, journals, and journal entry lines can be modified or deleted if the batch has not been posted.
Manual Journal Entries

Batch Names

- **Non-Salary Cost Transfer**
  
  NSCT Department # Initials Date Tracking #

- **IDC's**
  
  IDC Department # Initials Date Tracking #

- **Cash Reports - Direct Deposit Areas**
  
  DDBank_ID Department # Initials Date Tracking #
  
  *For Cash Reports Only, Date = Deposit Date*

- **Cash Reports - Cashier's Office**
  
  CRX Bank_Reconciliation # Initials Date Tracking #
  
  *For Cash Reports Only, Date = Deposit Date*

Examples of Batch Names:

Type Dept Initials Date Tracking#

- NSCT 13203 KLP 1018 01
- IDC 49201 MCM 1017 001

The *Tracking #* is a letter or number used as needed to uniquely identify the batch.
**Manual Journal Entries**

Journal Entries by Central Accounting Areas, and Regional Campuses, replace a department number with an alphabetic Area/Department abbreviation.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Accounting Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUX</td>
<td>Auxiliary Administration</td>
</tr>
<tr>
<td>ADMIN</td>
<td>Central Administration</td>
</tr>
<tr>
<td>BFR</td>
<td>Budget and Financial Reporting</td>
</tr>
<tr>
<td>BR</td>
<td>Bradford</td>
</tr>
<tr>
<td>FIA</td>
<td>Financial Information Administration</td>
</tr>
<tr>
<td>FIS</td>
<td>Financial Information Systems</td>
</tr>
<tr>
<td>FRS</td>
<td>Financial Records Services</td>
</tr>
<tr>
<td>GA</td>
<td>General Accounting</td>
</tr>
<tr>
<td>GR</td>
<td>Greensburg</td>
</tr>
<tr>
<td>JO</td>
<td>Johnstown</td>
</tr>
<tr>
<td>OF</td>
<td>Office of Finance</td>
</tr>
<tr>
<td>OPA</td>
<td>Office of Planning and Analysis</td>
</tr>
<tr>
<td>PCI</td>
<td>Pittsburgh Cancer Institute</td>
</tr>
<tr>
<td>PP</td>
<td>Payment Processing (formerly AP, Accounts Payable)</td>
</tr>
<tr>
<td>PY</td>
<td>Payroll</td>
</tr>
<tr>
<td>RCA</td>
<td>Research and Cost Accounting</td>
</tr>
<tr>
<td>RM</td>
<td>Risk Management</td>
</tr>
<tr>
<td>SFA</td>
<td>Student Financial Svcs Administration</td>
</tr>
<tr>
<td>SAB</td>
<td>Student Accounting and Billing</td>
</tr>
<tr>
<td>SOMD</td>
<td>Senior Vice Chancellor, Health Sciences/School of Medicine</td>
</tr>
<tr>
<td>SPC</td>
<td>Student Payment Center</td>
</tr>
<tr>
<td>TI</td>
<td>Titusville</td>
</tr>
<tr>
<td>TX</td>
<td>Taxation</td>
</tr>
<tr>
<td>UCO</td>
<td>University Collections Office</td>
</tr>
<tr>
<td>UPMCD</td>
<td>University of Pittsburgh Medical Center Division</td>
</tr>
<tr>
<td>WPIC</td>
<td>Western Psychiatric Institute and Clinic</td>
</tr>
</tbody>
</table>
Manual Journal Entries

The Dean’s office for the School of Dental Medicine needs to create a journal entry to charge dental departments for the use of the Dean’s copier machine. You will be entering an IDC (Interdepartmental Charge) journal entry.

1. Navigate to the Find Journals window

Oracle General Ledger
N → Enter Journals
Find Journals

The Find Journals form enables a user to:

- Find an existing journal entry
- Enter a new journal entry

To find an existing journal entry so you can modify it:

- Enter the search criteria
- Click on the Find button
Batch Information

To create a new journal entry, you must start at the Batch level!

2. Click on New Batch to initiate a new journal batch

3. Enter a unique name in the Batch field, following GL batch naming conventions
   - IDC 49010 XXX MMDD # (Use all uppercase letters)
   - XXX represents user initials; MMDD is the date
   - # is an optional tracking number that is used when a user produces more than one batch per day.

4. Enter Period or accept current period name by pressing the Tab key
   - MMM-YY

5. Enter Batch Control Total
   - 1

   The use of the Batch Control Total will prevent posting of a journal entry until debits and credits equal the Batch Control Total or while a journal is in progress. A Batch Control Total = 1 can be used as a flag to indicate the batch is not to be posted.

6. Click on the Journals button
Journal Header Information

7. Enter Journal name
   - Dent Dean Copier Chg
   The Journal name should describe the purpose of the journal entry.

8. Enter (Journal) Description
   - Copier Chg MMM-YY
   This description becomes the default value in the Description field for each entry in the Line region.

9. Tab through Ledger field to accept default University of Pittsburgh

10. The Period defaults from the period entered at the Batch level.

11. Accept the default Category
    - Journal

12. The Effective Date defaults to the current date
    - Enter an Effective Date or press the Tab key to accept system date

13. Tab through Clearing Company field
Journal Entry Lines

14. Enter (Journal) Control Total
   - 45.67
   Oracle General Ledger verifies that the control total equals the running debit total. If there is a discrepancy, Oracle General Ledger displays a warning message before saving.

15. Click in the small flexfield found to the right of the Control Total field.

16. Enter Prepared By name
   - Your first name and last name

17. Enter Preparer’s Phone number
   - Your phone number

18. Enter Authorized By name
   - Your supervisor’s first name and last name

19. Enter Authorizer’s Phone number
   - Your supervisor’s phone number

20. Click OK

21. Acknowledge the warning message by clicking OK or pressing Enter.
Journal Entry Lines

22. Click on Other Information tab

23. Enter the Reference information
   - X4 Dent Dean

   The Reference field provides additional information about the transaction.

   For IDC’s, the Reference field contains an IDC authorization number and
   name/function of the issuing department.

   For NSCT transactions, the Reference field is optional. It can contain the batch
   name of the original journal entry from which the charge originated.

24. Click on Lines tab

25. Enter a unique Line number
   - 10

   Use of the number ‘10’ as the first line number causes the system to enter the next
   line numbers automatically in increments of 10. This makes it easier to add lines
   between existing lines if necessary.

26. Enter Account
   - 02.49201.6891.00000.000000.00000.00000

   If you enter the first two digits of the account entity and press [Tab], the system will
   automatically bring up the PITT_PRODUCTION COA window with zeros in the
   Reference and Unspecified fields.
27. Click *OK* after all segments are complete

28. Enter *Debit (USD)* amount

   • 18.55

29. Move to the next row by pressing the *Down Arrow* on your keyboard

30. Enter the following values in the same manner as Steps 20-23

<table>
<thead>
<tr>
<th>Line</th>
<th>Account</th>
<th>Amount</th>
<th>Debit/Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>02.49202.6891.00000.000000.000000.000000</td>
<td>14.75</td>
<td>Debit</td>
</tr>
<tr>
<td>30</td>
<td>05.49201.6891.00000.002692.00000.000000</td>
<td>1.35</td>
<td>Debit</td>
</tr>
<tr>
<td>40</td>
<td>05.49203.6891.00000.002693.00000.000000</td>
<td>11.02</td>
<td>Debit</td>
</tr>
<tr>
<td>50</td>
<td>02.49010.6891.00000.0000000.00000.000000</td>
<td>45.67</td>
<td>Credit</td>
</tr>
</tbody>
</table>

Note: Any of the line descriptions can be modified to add more descriptive information.
Journal Entry Lines

31. Modify the (Line) Description for the last line with the credit
   
   - Recovery, copier charges, MMM-YR

32. Click the Save icon

33. The following Decision box will appear, because the Control Total in the Batch window is still entered as “1”.

34. Click Yes to continue saving
35. Return to the *Batch* window

36. Change the Batch *Control Total* to 45.67

37. Click the *Save* icon

38. Your journal entry is complete and is ready to be posted.
Lab 1: Entering a Non-Salary Cost Transfer

Charges for a printing job from CopyCat were charged, via an IDC, to an operating account. You determine that the charges should be moved to your principal investigator’s (Dr. Lu’s) grant account. Create a non-salary cost transfer to redistribute the charges from the operating account to the grant account.

Origination of Charge: Printing of Dr. Lu’s report by CopyCat. Charged via an IDC.

Original Batch Name: IDC 02053 KJM 0103

Original Account: 02.49010.6894.00000.000000.000000.00000.00000

Correct Account: 05.49010.6894.00000.002691.00000.00000

Amount: $145.50
Lab 1 Solutions: Entering a Non-Salary Cost Transfer

Batch Information

Journal Entry Header Information

OPTIONAL: The Reference field can contain the batch name for the journal entry from which the charge originated.
Lab 1 Solutions: Entering a Non-Salary Cost Transfer

Prepared By/Authorized By flexfield contains the name and phone number of the Preparer and Authorizer

Journal Entry Header and Lines
Lab 2: Entering a Multi-Entity Journal Entry

Your director, Dr. Gray, traveled out-of-town to give a lecture. Two expense transactions related to this trip were erroneously charged to the Dean’s Office operating account and need to be transferred to the Dean’s discretionary account.

Dean’s Office Operating: 02.49010.ssss.00000.000000.00000.00000

Discretionary Account: 04.49010.ssss.22950.000000.00000.00000

Charges/Subcodes/Amounts:

- Professional Services – 6400 $1575.00
- Domestic travel – 6300 2555.50
- Total $4130.50

1. Create a journal entry to transfer these charges.

2. What is unusual about this set of entries?
Lab 2 Solutions: Entering a Multi-Entity Journal

Batch Information

Journal Header and Lines – Before Posting
Lab 2 Solutions: Entering a Multi-Entity Journal

- Since the transactions involve more than one entity, the system will automatically create “Intracompany balancing line” transactions to bring the entities into balance.
- You do not see the Intracompany lines the system adds because they do not hit departmental accounts, but notice that the Control Total has doubled.
- No actions should be taken by the user to modify these transactions.

Journal Header & Lines after Posting – Dept. View
Lab 2 Solutions: Entering a Multi-Entity Journal

Journal Header & Lines after Posting – Central Admin.view
Lab 3: Entering a Multi-Department Journal

The Dental Medicine Dean’s Office and the Environmental Health Department (GSPH) wish to set up an education booth at a local community fair to distribute information about environmental health and its effects on dental health.

The costs include

- Advertising $150.00
- Printing 600.00
- Equipment rental 150.00
- Production video 750.00
- Other costs 175.00
- Total $1825.00

Both departments have agreed to split the costs in equal portions. The Dean’s Office will incur the full costs and then generate a journal entry to transfer half the costs to Environmental Health.

Dental Dean: 02.49010.ssss.00000.000000.00010.00000

Environmental Health: 02.34204.ssss.00000.000000.00010.00000

Subcodes to be used:

- Advertising 6410
- Printing, Copy Cat 6891
- Equipment rental 6200
- Photography, external 6815
- Inter-department, Other Printing 6894

How should the Dental Dean’s Office handle this journal entry?
Lab 3 Solutions: Entering a Multi-Department Journal

Online Entry of Non-Salary Cost Transfers that Cross Departments or Responsibility Centers Outside of Current PRISM Access Restrictions

This method can only be used if all of the following conditions are met:

- Both the Originating and Target Departments agree to the transaction
- Both Departments involved in the entry have PRISM online General Ledger entry access
- The transaction is NOT part of an IDC or Cash Report
- The transaction does not affect an account number designated for central or general University use

- If all of the conditions noted above are met and you are entering a transaction that affects a departmental* account you do not have access to, the entry may be done online by adhering to the following procedure:

Originating Department (Department whose account contains the amount/s to be corrected or redistributed)

1) Create an NSCT batch in PRISM General Ledger using the standard batch naming convention placing a 1.00 in the BATCH total

2) Enter the portion of the transaction affecting the Originating Department's account using line numbers between 1 and 49,

3) Enter the Preparer and Approver information of the Originating Department.

4) Save the batch.

5) Notify the Target Department of the need for completion of the entry and provide them the batch name that was created and any additional information as requested.

6) Upon notification of completion by the Target Department, change the batch control total to the proper amount for posting purposes. **NOTE: It is the sole responsibility of the Originating Department to ensure that the batch is properly completed and the batch control total is changed to the proper amount by the monthly cutoff date and time for the appropriate GL period.**

7) It is also the responsibility of the Originating Department to maintain all supporting documentation related to the full transaction according to record retention guidelines and to supply copies of this documentation to the Target Department if requested.
Lab 3 Solutions: Entering a Multi-Department Journal

**Target Department** (Department who will be the recipient of the transaction.)

1) Open the entry in PRISM according to the batch name provided by the Originating Department.

2) Enter the portion of the transaction affecting Target Department’s account using line numbers between 50 and 99 on the SAME journal page within the batch.

3) Save the batch.

4) Notify the Originating Department upon completion of the entry. Note: The Target Department may request copies of supporting documentation from the Originating Department if needed.
**Modifying/Deleting Journal Entries – Inserting a Record**

*Unposted* journal entries can be modified or deleted. *Posted* batches cannot be modified or deleted. Correcting a journal entry for a posted batch requires the creation of another journal entry.

**Modify the IDC batch you entered by inserting a new record (line).**

1. Navigate to the *Find Journals* window

   Oracle General Ledger
   N → Enter Journals
   Find Journals

2. Enter selection criteria, such as *Batch* name and *Period*
   - IDC 49010 XXX%  (where XXX are your initials)

3. Click *Find*
4. Note that the Batch Status is Unposted

5. Click **Review Journal** to view journal header/line information
6. Insert a new record between lines 40 & 50

- Position the cursor on line 40
  
  Note: General Ledger will insert a new line directly below the line on which the cursor is located

- Click the Insert Record button on the Toolbar
Modifying/Deleting Journal Entries—Inserting a Record

7. Enter new data in appropriate fields of line 41
   - **Account:** 04.49010.6891.22950.000000.00000.00000
   - **Debit:** 20.00

8. Update the following fields to 65.67
   - **Credit**
   - Journal **Control Total**
   - Batch **Control Total**

9. Save your work
Modifying/Deleting Journal Entries – Changing a Batch Period

Change the batch Period for the Non-Salary Cost Transfer you created.

Transactions can be posted to any period if the period is open.

- Changing a period on an unposted batch becomes necessary if a previous period is still open (first three working days of each month) and a transaction must be applied to the previous period.
- If you change the period for an unposted batch, General Ledger updates the posting date for each journal entry.

1. Navigate to the Find Journals window

Oracle General Ledger
N → Enter Journals
Find Journals

2. Enter selection criteria: Batch name, Period, Posting Status
   - Use the % as a wildcard symbol in the Batch name field
Modifying/Deleting Journal Entries – Changing a Batch Period

3. Click Find

4. Click Review Batch

5. Click Change Period
7. Enter the new batch \textit{Period} in the \textit{To} field

General Ledger assigns either the first or last day of the new period as the new \textit{Effective Date}, depending on which date is closer to the creation date.

8. Click \textit{OK} to save the revised batch

9. The Period fields at the batch and journal level will be updated.
Deleting a Batch

Delete the IDC batch that you created.

1. Navigate to the Find Journals window from an Entry responsibility, not Inquiry

2. Enter selection criteria: Batch name, Period
   - Use the % as a wildcard symbol in the Batch name field

3. Click Find

4. Position your cursor on the batch to be deleted and click Review Batch
Deleting a Batch

5. Select Edit, Delete Record from the Menu Bar, or click the Delete Record icon on the Tool Bar

6. The message “Are you sure you want to delete this batch?” appears

7. Click Yes

8. Perform a Save

9. The batch is deleted from the PRISM system
Reversing a Journal Entry

Capabilities of the Automated Reversing Process

- This process will automatically create a reversing journal entry of the original entry. You cannot select specific entries on a journal page for reversal. **All entries on a journal page will be reversed.**

- You can choose to reverse a single journal page or all journal pages of a batch.

- You can reverse the journal page to any *open* period or *future entry* period.

- You can automatically reverse a journal page only once.

- You can reverse a reversing journal by the same method.

**Note:** The system will create a batch beginning with “**Reverse**” followed by the journal name of the original journal page in quotes.

Reasons for Reversing a Journal Page

- You have entered a journal page within a batch. The journal batch which contains the journal page/s has been **Posted**. You decide a particular journal page/s in its entirety should not have been entered or has been entered incorrectly.

- A particular journal page has been duplicated and both the original and duplicate have been **Posted**.
Reversing a Journal Entry

Procedures for Creating an Automated Reversing Journal Entry

1. Query the posted batch by using Enter Journals on your Navigation menu.

2. Click on Review Journals.

3. If there are multiple journal pages within the batch, select the journal page you want to reverse by moving your cursor to the top of that page.

4. In the Reverse window, enter the period in which you want the journal page to be reversed.

5. Save your changes.

Warning:

- Only the preparer of the posted journal or an authorized individual from the preparer’s Department can initiate/authorize an automated reversal of the journal.

- Enter the period in the Reverse window only if you want the journal page to be reversed.

- Once you have marked a journal page to be reversed, it will be generated and posted within the period you have selected, without any additional verification.
Journal Entry Inquiry

Section Objectives

At the end of this section, you should be able to:

- Review transactions from a specific batch or batches
- Review journal entry details
- Drilldown into journal entry line details
Journal Entry Inquiry

Journal Entry Inquiry

- Shows all transactions, unposted as well as posted

- Shows batch details
  - Drilldown to journal entry level
  - Drilldown to the line level for each journal entry

- Form is automatically in query mode when accessed

- **Form may not be used to change journal information**
**Journal Entry Inquiry**

**Inquire on an IDC batch from DEC-15**

Oracle General Ledger

N → Inquiry → Journals

Find Journals

![Find Journals screenshot](image)

1. Enter selection criteria in the appropriate fields using the percent sign ( % ) as a wildcard symbol:
   - Batch name: IDC 49010 CAL%
   - Period: DEC-15

2. Click *Find*
Journal Entry Inquiry

3. An IDC for copy charges should have been found

4. Click Review Batch

5. From the Batch window you can review
   - Batch name, Period, Balance Type, & Description (optional)
   - Posting Status
   - Created & Posted Dates
   - Batch Control Total
   - Entered Debits & Credits
Journal Entry Inquiry

6. To review journal entry information for a specific batch, click Review Journal.

7. Use the scroll bars to move your lines into view.

8. Click anywhere in the Lines Region.

9. To find a specific Debit or Credit line, click on the Find icon from the Tool Bar.
10. You can find Journal Entry lines by specifying:
   - Line Numbers
   - Entered Debit/Credit Amounts
   - Account Numbers
   - Description

11. Enter 24.56 in the Debit field

12. Click Find
13. The system will display all Journal Entry Lines that have 24.56 in the *Debit* column
14. To look at the Prepared By / Authorized By information, click in the user information block [ ].

15. Close the Preparer/Authorizer window.

16. To return all Journal Lines, click at the Line level, then click on the Find Icon.
   - Click on Clear and then Find.

17. Click File, Close Form to return to Navigator.
Lab 4: Journal Entry Inquiry

1. Use the Journal Entry Inquiry window to retrieve all NSCT batches entered for the current month.
   - How many batches were retrieved?
   - How many batches did you create?
   - What is the Posting Status of your batch?
   - Could you modify your or another person’s batch from this screen?

2. Does department 49010 have any unposted batches for December 2015?
   - How many batches were retrieved?
   - What needs to be corrected before the batches can be posted?
Lab 4 Solutions: Journal Entry Inquiry

1.

- Varies depending on number of students in the class.
- 1
- Unposted
- No. Journal Entry Inquiry is view only.

2. Yes

- 2
- NCST 49010 CAL 1210 01 (Control Total is missing at the Batch level, Incorrect Batch Name)
- NSCT 49010 CAL 1210 02 (1 in the Control Total field at the Batch Level, blank space at beginning of Batch Name, Journal Control Total is missing)
Account Inquiry

Chapter 4
Section Objectives

At the end of this section, you should be able to:

- Review posted entries to GL account balances
- Review budget or actual balances by account number
- Drilldown into batch and journal entry details
- Review information for each journal entry line affecting the current account number
Account Inquiry

• Provides detailed information about a specific account number or range of account numbers for a specified period
  – Does not show funds available
  – Shows posted entries only

• Shows two balance types at once
  – Actual
  – Budget

• Reviews journal entry details
  – Drill down from account balances to journal entry detail
  – Review information for each journal entry line affecting the current account
  – Shows the effect of charges to the account
Account Inquiry

Use the Account Inquiry window to view balance information for a computer supplies account for the Orthodontics Clinic. Use the drilldown feature to view invoicing and payment information for Payables batches.

1. Navigate to the Account Inquiry screen

   Oracle General Ledger
   N → Inquiry → Account
   Account Inquiry

   ![Account Inquiry Window](image)

2. Enter starting Accounting Period (From field)
   - DEC-15 <Tab>

3. Enter ending Accounting Period (To field)
   - DEC-15 <Tab>
Account Inquiry: Selection Criteria

4. Accept Default settings
   - Currency – Single Currency & USD
   - Primary Balance Type – Actual
   - Factor -- Units

5. Click in the Accounts field to enter Account Number (Low/High) ranges

6. Enter Account Number (Low/High) ranges

In the Inquiry screens, unused segments can remain blank.

7. Click OK
8. The Account Inquiry screen will Show Balances, Show Journal Details, and Show Variance by individual accounts.

9. Click Show Balances.
Account Inquiry: Show Balances

Show Balances shows the period to date and year to date balances for the periods specified.

10. Move your cursor to the line of the period for which you want more information.
   - Period: DEC-15

11. Click Journal Details
Show Journal Details shows the batches making up the balance for the specified period.

12. In this instance, there is a Manual batch, and several Payables batches.

   Notice how the Drilldown button is not available for the NSCT batch. That is because the Source of that batch is Manual. Payables batches (Source is Payables) allow drill down into more information such as invoicing and payments.

13. Keep your cursor on the first batch.

Account Inquiry: Show Journal Details

Show Full Journal allows you to view the details of the Journal Entry

15. Close the Journals windows
16. Several Payables also make up the activity for DEC-15

- When the Source field says Payables you will be able to drilldown to invoicing and payment information.

17. Place your cursor on the second Payables line, and click Drilldown.
18. From this screen you can see additional information on the expense for $58.25
   - The expense is for $58.25, the supplier is CDW Government Inc, and the invoice # is CDW003

19. Click *View Transaction* to see additional details
20. This takes you to the Invoice Workbench where, in addition to general invoicing information, you can view the following:

- **Holds**
- **Payments**
- **Scheduled Payments**
- **Prepayment Applications**
- **Distributions**

21. Click Views Payment to see Payment Details
22. From this screen you can see:
   - Check number (document number)
   - Payment Date
   - GL Date
   - Payment Amount

23. Click Payment Overview to see additional Payee and Invoice detail
Account Inquiry: Drilldown to Payments

24. Close out of Payment Overview

25. Click on All Distributions
26. View the following:

- Invoiced Amount
- GL Date (date expense is charged to your account)
- Account charged
- Expense Description

27. Following the same procedures, drill down on the expense for $179.99

28. What was the expense for?
Account Inquiry: Drilldown to Payments

- Manual and Payable Transactions

- Journal Entry line information
- The item is from CDW Government Inc.; the invoice # is CDW001
- Click View Transaction
Account Inquiry: Drilldown to Payments

Invoice and Payment Details

Distribution Detail
Lab 5: Account Inquiry

1. Use the Account Inquiry form to review the status of the processing of Travel and Business Expense reports for Cathy Lewis during the period DEC-15.
   - Set your Accounting Periods from DEC-15 to DEC-15.
   - Expenses were charged to account 02.49010.6300
   - Drill down to invoicing and payment information.
   - Answer the following questions:
     - How many T&B's were submitted?
     - What was the purpose of the travel?
     - Did Cathy receive payment?

2. A person in your department purchased a book from Amazon.com on a PCard. The cost was $27.80. The book was returned in March for a credit. You want to make sure you have received the credit. The default PCard account is 02.49010.6000.
Lab 5 Solutions: Account Inquiry

Question 1 – Status of T&B's

- Enter Selection Criteria
- Click Show Balances

- Place cursor on the line for which you want detail
- Click Journal Details
Lab 5 Solutions: Account Inquiry

- There are several Payables transactions
- Keep your cursor on the first batch line
- Click Drilldown

- Transaction No. is the Expense Report No.
- Supplier Name is the person being reimbursed
- Click View Transaction
Lab 5 Solutions: Account Inquiry

- Invoice Screen shows Payee, invoice amount and payment amount of the T&B
- Description shows the purpose of the travel
- Click All Distributions to see Travel Report expense details
Lab 5 Solutions: Account Inquiry

2\textsuperscript{nd} Expense Report

- Place cursor on the third Payables transaction
- Click \textit{Drilldown}

- Click \textit{View Transactions} for the second Expense Report
Lab 5 Solutions: Account Inquiry

- Invoice and Payment Information

- Payment Details
Lab 5 Solutions: Account Inquiry

- Distribution Details

<table>
<thead>
<tr>
<th>Num</th>
<th>Type</th>
<th>Amount</th>
<th>GL Date</th>
<th>Account</th>
<th>Asset Book</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>20.00</td>
<td>11-DEC-2015</td>
<td>02.49010.6021.00000.000000.00</td>
<td>Emergency Computer Supplies</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Item</td>
<td>88.50</td>
<td>11-DEC-2015</td>
<td>02.49010.6300.00000.000000.00</td>
<td>Partial Day Per Diem</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Item</td>
<td>100.00</td>
<td>11-DEC-2015</td>
<td>02.49010.6300.00000.000000.00</td>
<td>Taxi/Car Service</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Item</td>
<td>177.30</td>
<td>11-DEC-2015</td>
<td>02.49010.6300.00000.000000.00</td>
<td>Meal Per Diem (Domestic)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Item</td>
<td>425.00</td>
<td>11-DEC-2015</td>
<td>02.49010.6300.00000.000000.00</td>
<td>Lodging</td>
<td></td>
</tr>
</tbody>
</table>
Lab 5 Solutions: Account Inquiry

Question 2: Was a credit received?

- Enter Selection Criteria
- Click Show Balances
- Click Journal Details
Lab 5 Solutions: Account Inquiry

- Since there are many lines, query for the credit for $27.80
- View, Query by Example, Enter (27.80). View, Query by Example, Run.
- Place your cursor on that record
- Click Drilldown
Lab 5 Solutions: Account Inquiry

- Supplier is Amazon.com

- Identify that the invoice is a credit related to a PCard purchase

- Click on All Distributions to see that $27.80 was credited to 02.49010.6000.

Note: Credits display as negative amounts.
Lab 5 Solutions: Account Inquiry

- Distributions
Viewing Funds Available

Chapter 5
Section Objectives

At the end of this section, you should be able to:

- Review funds available in specific accounts or within significant segment values by budget and actual amounts

- Drilldown to view associated journals or invoicing and payment information
Viewing Funds Available

Inquiry vs. Entry

The View Funds Available form is an inquiry only form, preventing any modification to information.

Reviewing Account Amounts

View Funds Available allows review of:

- Budget and actual amounts
- Funds available for specific accounts
- Drilldown to view associated journals or invoicing and payment information

Funds available is your budget less any expenditures

Funds Available = Budget - Actuals

View Funds Available provides immediate, up-to-the-minute financial information, and includes posted and unposted entries
Viewing Funds Available

Review available funds by comparing actuals against budgets.

Oracle General Ledger
N → Inquiry → Funds
Funds Available Inquiry

Enter the selection criteria

1. Enter Budget: Accept default by pressing <Tab>
   - UNIVERSITY (Default)

2. Enter Amount Type: Accept default by pressing <Tab>
   - Year to Date Extended (Default) – Cumulative balances from the start date of the fiscal year until the specified period, including adjustment periods
   - Project to Date Extended - Cumulative balances from the start date of the account until the specified period, including adjustment periods

3. Enter Period: DEC-15

4. Encumbrance Type & Account Level remain at the default settings
Selection Criteria

5. Enter Accounting Flexfields (Low/High)

- In an Inquiry screen, unused Flexfield segments can remain blank.

6. Click OK
7. For each Account that displays, you can view a Budget and Actual amount and the resulting Funds Available
   - The position of the cursor on a line determines the display for the Account Description at the bottom of the screen.

8. Review the Account Description. To what department and what subcode were these charges made?

9. What do the < > symbols enclosing a number signify?
Funds Available Inquiry Drilldown

View the Detail behind the Actual Expenses

1. Place your cursor on the line that has an actual expense of $1362.49.

2. Click **Tools**

   - **Tools**
   - **Window**
   - **Help**
   - **Period Balances**
   - **Detail Accounts**
   - **Budget Lines**
   - **Actual Lines**
   - **Encumbrance Lines**

3. Select **Period Balances**
4. Scroll through the months until you locate the month that contains the activity you want to look at. There was activity on this account in December.

5. Click on the December record

6. Click Tools

7. Select Actual Lines
8. Click *Journal* for manual GL transactions or *Drilldown* for Payable transactions
   - For Payable transactions, the *Source* field will say “Payables”
   - For manually entered journals, the *Source* field will say “Manual”

9. Click *Drilldown* for the first Payables line
10. Notice the charge is for an item from Dell Marketing LP.

11. Click on View Transaction to see invoicing and payment details.

- Invoice and Payments Information
Funds Available Inquiry Drilldown

- Distribution Details
Lab 6: View Funds Available

1. Use the View Funds Available window to review the status of the following accounts and determine the Funds Available amount using the following selection criteria:

   - Budget: UNIVERSITY
   - Period: DEC-15

   - 05.49203.6894.00000.002693.00000
   - 02.49201.6021.00000.00000.00000
   - 02.49202.6010.00000.00000.00000

2. What Amount Type would you use for each and why?

3. **Perform a drilldown on the activity for the 05 account number. View the details.
Lab 6 Solutions: View Funds Available

1. Funds Available Amounts:
   - 05.49203.6894.00000.002693.00000 <15.85>
   - 02.49201.6021.00000.000000.00000 99,261.86
   - 02.49202.6010.00000.000000.00000 224,937.64

2. The choice of Amount Type varies with the account’s Entity and inquiry situation. Normally, Project to Date is used with Entity 05 accounts when budgets and balances may cross multiple fiscal years. Year to Date Extended is used with the other entities to review fiscal year balances. However, Year to Date Extended may be used with Entity 05 accounts to review their balances for just the current fiscal year.

3. Drilldown on account 05.49203.6894.00000.002693.00000

   ![Image of the software interface showing funds available with drilldown options]

   - Click on Tools, Period Balances
Lab 6 Solutions: View Funds Available

- Position cursor on the period for which you want to drill down
- Click on Tools, Actual Lines
Lab 6 Solutions: View Funds Available

- Position cursor on the line you would like to view, then click **Journal** if it is a Manual transaction or **Drilldown** if it is a Payables transaction.

- The charge was generated via an IDC type Journal Entry for copier usage.
Running Oracle Reports

Chapter 6
Running Oracle Reports

Section Objectives

At the end of this section, you should be able to:

- Run standard reports
- Run Financial Statement Generator (FSG) reports
- Review concurrent manager for requests
- Save reports for viewing online
- View diagnostics, request logs, and reports online
- Reprint reports
- Copy output and transfer to your PC
- Cancel running requests
## GL Reports

<table>
<thead>
<tr>
<th>Name</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Analysis - (132 Char)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>Budget - Journal by Account</td>
<td>General Ledger</td>
</tr>
<tr>
<td>General Ledger - (132 Char)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>General Ledger - (180 Char)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>Journals - (132 Char)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>Journals - General (180 Char)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - OL Summary</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - OL Summary (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Budget Variance Detail</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Budget Variance Summary</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Budget Variance Summary (Fin.Aid)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Budget Variance Summary by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.1</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.1 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.2</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.2 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.3</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 1.3 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 1</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 1 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 2</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 2 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 3</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - IGS Summary 2 3 by Dept</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS (02 &amp; 03)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS (04 &amp; 05-40)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Detail (02 &amp; 03)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Detail (04 &amp; 05-40)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Detail (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary (02 &amp; 03)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary (04 &amp; 05-40)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary (Fin.Aid)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary by Dept (02 &amp; 03)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>PGL FSG - Level II IFS Summary by Dept (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>Test Custom: PGL Level II US (05)</td>
<td>General Ledger</td>
</tr>
<tr>
<td>Pitt's Chart of Accounts (Request Only) - FOAR300</td>
<td>Pitt GL Custom</td>
</tr>
</tbody>
</table>
GL Standard Reports

General Ledger Standard Reports

- Standard reports are pre-defined reports that allow you to review financial information

- Users have access to certain reports based on their responsibility

- Reports may run at any time and are submitted via the Submit Requests form

- Reports may not be executed immediately when requested. A report request is sent to a utility program called the Concurrent Manager.
  - The Concurrent Manager coordinates the processing of several requests simultaneously
  - You can do other tasks while the Concurrent Manager is processing your request

- Users have the option of reviewing the output of a report online in addition to printing a hard copy of the output

General Ledger Standard Reports

Account Analysis**

Lists the accumulated balances of a single account or a range of accounts and all journal entry lines that affect that range; can not cross fiscal years.

Budget - Journal by Account:

Contains information about budgets loads and modifications, by account numbers.

Chart of Accounts:

Provides information about the accounts in Pitt’s Chart of Accounts, including segment values, rollup ranges and suspense accounts.

General Ledger**

Lists the accumulated balances of a single account or a range of accounts and all journal entry lines that affect that range; can cross fiscal years.
GL Standard Reports

Journals**

Provides journal information including posted, unposted, and error journals. You can also review journal activity for particular periods and balancing segments. The Journals-General report will print out a hard copy of your journal entry.

General Ledger Custom Reports

Financial Statement Generator (FSG)

FSG’s are custom built reports that provide summary information (i.e. no transaction detail) for a specific period selected by the user.

Refer to the PRISM website, www.cfo.pitt.edu/prism, under Training Materials, for complete documentation on running FSG’s.

Report Parameters

- Most print requests require you to enter parameter values so you can specify the scope of information you want to see in the output
- Prompts in the Parameters window are specific to the request you select

Sample parameters for a Journals-General report
**GL Standard Reports**

- Some parameter fields have a *List of Values* available to ensure you choose a valid parameter value while other parameters are optional and require no value

- Default values may be predefined for one or more of the parameters associated with your request.

- Default values are automatically applied to these parameters when the *Parameters* window is opened

**Using the *Concurrent Requests* Windows**

You can use the *Concurrent Requests* windows (summary and detail) to:

- View a list of all submitted concurrent requests

- Check whether your request has run

- Change aspects of a request's processing options

- Diagnose errors

- Find the position of your request in the queues of available concurrent managers

- Copy output to your PC

- Cancel a request

- You can navigate to the *Concurrent Requests* windows using the *Navigator* window.

- Different Oracle Applications products use different menu paths in the *Navigator* window to access the *Concurrent Requests* windows.
Run Standard Reports

Print an Account Analysis report for the period DEC-15 for account number 02.49201.6000-6999

1. Navigate to the Submit Requests window

   Oracle General Ledger
   N → Reports → Request → Standard
   Submit Requests

   or

   Oracle General Ledger
   N → Other → Reports → Run
   Submit Requests

2. Determine the type of request you want to run
   
   - Single Request

3. Click on OK
4. Click in the *Name* field.

5. Select the *Name* of the report you want to run from the *List of Values*:
   - Account Analysis (180 Char)

   Note: Your responsibility's request group determines which reports appear in the list.

6. Click on *OK*
Run Standard Reports

7. Enter the following request parameters, starting with Type

![Parameters screenshot]

Note: the first four fields contain default values which should not be altered.
Run Standard Reports

8. Click OK to return to the Submit Request window

9. Click the Options button to open the Upon Completion window
10. Be sure a checkmark appears in the *Save all Output Files* box

11. Select *Style*
   - Landscape

12. Change *Printer* if necessary

13. Enter number of *Copies*
   - 0
View Reports Online

Entering a zero (0) indicates you want to view the report online
Entering a one (1) indicates you want a hard copy of the report

14. Click OK to return to the Submit Requests window

15. Click the Submit button.
   - This automatically opens the Requests window.

16. Determine if your report is completed.
   - The most recently run report will appear at the top of the list.
   - Check the Phase field to see if the status is Completed.
   - If the report is still running, click on the Refresh Data button to refresh the screen until the Phase field says Completed.

17. Click on the View Output button to view the report online once it completes running.
18. To view more of the report on the screen, change the font size.

19. The vertical and horizontal scroll bars will move you through a page of your report.

20. Use the button: Go To, First, Previous, Next, and Last to move through pages within the output.
   - If you click Last and then look in the upper left-hand corner of the window, you will see the total number of pages in the report.

21. If you have a printer setup for PRISM printing a copy of the report will automatically be sent to the designated printer.

22. You can print a hard copy of the report, while viewing the output, even if you have not set-up a printer for PRISM printing.
   - Click on Tools, Copy File
   - A copy of the report is opened up in Internet Explorer
   - In the browser window, click File, Page Setup
     Select the Landscape option
   - Click File, Print
**Reprint Option**

To print a hard copy of a report after viewing it online, start at the Navigator window.

1. Navigate to the *Find Requests* window

   Oracle General Ledger
   N → Other → Requests  or  N → Other → Reports → View
   Find Requests

2. Accept the default request choice
   - *All My Requests*

3. Click on *Find* to open the *Requests* window

4. Select the desired report
5. Click on Tools in the Menu Bar; select Reprint/Republish.
Reprint Option

6. Enter the desired options in the Republish and Reprint Request window
   - Copies 1
   - Printer Your default printer
   - Style Landscape

7. Click Apply

8. Click OK to confirm reprint

9. Close Window
Copy Output to another Application

Copying your report allows you to transfer the report file from PRISM to your PC using Internet Explorer commands

1. Navigate to the Find Requests window

   Oracle General Ledger

   N → Other → Requests  or  N → Other → Reports → View

   Find Requests

2. Accept the default request choice
   - All My Requests

3. Click on Find to open the Requests window

4. Select the desired report

5. Click on View Output
Copy Output to another Application

6. Click on Tools on the Menu Bar

   - Select Copy Files

Browser will build a separate window showing the first page of your output

7. Select the File, Save As command from the Menu bar

8. Enter appropriate path and filename for the output file and add “txt” as an extension

9. Close the browser output window

10. Open your PC application, such as Excel or Word, and then open the text output file

11. Use the appropriate application commands to turn your text file into the application’s format for data
Cancel a Request

Submitted requests can be cancelled if the job phase is Pending or Running

1. Navigate to the Find Requests window

   Oracle General Ledger
   N → Other → Requests or N → Other → Reports → View
   Find Requests

2. Accept the default request choice
   - All My Requests

3. Click on Find to open the Requests window

4. Select the job to be terminated by positioning your cursor on the appropriate line

5. Click on Cancel Request

6. Save the transaction
**Run FSG Reports**

Refer to the PRISM website, [www.bc.pitt.edu/prism](http://www.bc.pitt.edu/prism), under Training Materials, for complete documentation on running FSG’s.

Print an FSG report called FSG – Level II I/S (02&03) for the period DEC-15 for department 49010.

1. Navigate to the *Submit Requests* window

   Oracle General Ledger  
   N → Reports → Request → Standard  
   Submit Requests

   or

   Oracle General Ledger  
   N → Other → Reports → Run  
   Submit Requests

2. Determine the type of request you want to run
   - *Single Request*

3. Click on OK
4. Click in the Name field.

5. Select the name of the report you want to run from the List of Values
   - PGL FSG – Level II I/S (02&03)

6. Enter the following parameters
   - Period: DEC-15
   - Ledger: Pitt
   - Entity: 02
   - Department: 49010

   *Note: In FSG’s, the account number segments are referred to as Segment Overrides. The segment override feature allows you to limit a report to a specified segment value. Currently, you are restricted to using the Entity and Department segments.*

   *Remember to Clear the pre-filled values 00000 for Reference and Unspecified if you are using the Segment Override feature.*

7. Click OK to return to the Submit Request window
Run FSG Reports

8. Click the Submit button
   - This automatically opens the Requests window

9. Determine if your report is completed
   - The most recently run report will appear at the top of the list
   - Check the Phase field to see if the status is Completed
   - If the report is still running, click on the Refresh Data button to refresh the screen until the Phase field says completed

10. Click on the View Output button to view the report online once it completes running
Lab 7: Run Standard Reports

The Journals-General Report will give you a hard copy print out of your Journal Entries

1. Run the Report Journals-General (180 char) for the Non-Salary Cost Transfer you entered to transfer charges from CopyCat.
Lab 7 Solutions: Run Standard Reports

N → Reports → Requests → Standard or
N → Other → Report → Run

Report Name

Report Parameters – Required Fields
Lab 7 Solutions: Run Standard Reports

- Submit Report
- Click *Refresh Data* until it is Completed
- Click *View Output* to view completed report
Lab 7 Solutions: Run Standard Reports

<table>
<thead>
<tr>
<th>Line Account</th>
<th>Transaction Date</th>
<th>Description</th>
<th>Debits</th>
<th>Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 02.00010,0994.00000,00000,00000,00000</td>
<td>10-FEB-14</td>
<td>COPYCAT CRS LU'S RPT</td>
<td>145.50</td>
<td></td>
</tr>
<tr>
<td>20 05.00010,0994.00000,00000,00000,00000</td>
<td>10-FEB-14</td>
<td>COPYCAT CRS LU'S RPT</td>
<td>145.50</td>
<td></td>
</tr>
</tbody>
</table>

**Total:**

<table>
<thead>
<tr>
<th>Debits</th>
<th>Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>145.50</td>
<td>145.50</td>
</tr>
</tbody>
</table>

**Balance:**

<table>
<thead>
<tr>
<th>Debits</th>
<th>Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>145.50</td>
<td>145.50</td>
</tr>
</tbody>
</table>

**Total:**

<table>
<thead>
<tr>
<th>Debits</th>
<th>Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>145.50</td>
<td>145.50</td>
</tr>
</tbody>
</table>
Section Objectives

At the end of this section, you should be able to:

- Access the Office of the Chief Financial Officer website
- Access the PRISM website
- Update your Printer Profile
Office of the Chief Financial Officer Website

Office of the Chief Financial Officer website

1. Double-click on the Internet Explorer icon.

2. Enter the following URL:

   http://www.cfo.pitt.edu

3. Notice that the topics are organized by departments and resources within the Office of the Chief Financial Officer.
Office of the Chief Financial Officer Website

4. Navigate through the menu items to find the information you desire

5. For instance, click on the Payment Processing link, then the Inquiries link (in the gold area) to access the form to enter online inquiries about payment information.

Type of Inquiry:

- Check Identification: check this box to obtain additional information about a check
- Disbursement Request: check this box to obtain information about the status of a special handling or regular disbursement
- Foreign National Payments: check this box to obtain information or assistance with a payment to a Foreign National
- Over $5000 Invoice Approval: check this box to approve payment of an invoice greater than $5000
- Purchase Order Invoice: check this box to obtain information about the status of a payment related to a Purchase Order
- Request for Cancelled Check: check this box to request a copy of a cancelled check
- Stop Payment: check this box to request placement of a stop payment on a previously issued check
- Travel Advance: check this box to obtain information or assistance with a Travel Advance
- Travel & Business Expense Report: check this box to obtain information or assistance with a Travel and Business Expense Report
- Other: check this box to obtain information or assistance with Payment Processing policy/procedure questions
PRISM Website

Access the PRISM website to obtain PRISM information.

1. Double-click on the Internet Explorer icon.
2. Enter the following URL:
   
   http://www.cfo.pitt.edu

3. Click on the PRISM link found under the Resource Links column.
4. Navigate through the menu items to find the information you desire, such as

- How to install the Sun Java Plug-in
- PRISM printing prerequisites
- Schedule of monthly cutoff dates and times for online journal entries
- Chart of Accounts (includes subcode listing)
- PRISM training manuals
- PRISM training schedule
5. Click on the following link.

![SUN Java Plug-in Installation Instructions (PDF)](link)

6. Notice that this gives you the instructions for downloading the plug-in for PRISM.

7. Click on FAQ.

8. Click on *How Do I setup a printer for PRISM printing?*
PRISM Website

9. Review the instructions for getting a printer setup.

10. Click on the Back key to return to the PRISM homepage.

11. Click on Subcode Listings and Reference Numbers, Expenses to see a listing of expense subcodes.

<table>
<thead>
<tr>
<th>NON-PERSONNEL COSTS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplies &amp; Office Furniture</td>
<td>Expendable, tangible personal property costing less than $5,000</td>
</tr>
<tr>
<td></td>
<td>per unit, including freight, postage, or other shipping costs.</td>
</tr>
<tr>
<td></td>
<td>Also includes items costing more than $5,000 per unit with a</td>
</tr>
<tr>
<td></td>
<td>useful life of less than two years. Excludes custom printed</td>
</tr>
<tr>
<td>6000 Office Supplies</td>
<td>materials which should be recorded under the category Printing</td>
</tr>
<tr>
<td></td>
<td>&amp; Publications.</td>
</tr>
<tr>
<td>6001 Office Supplies</td>
<td>General office supplies from external sources.</td>
</tr>
<tr>
<td></td>
<td>Excludes computers supplies and unallowable supplies such as</td>
</tr>
<tr>
<td></td>
<td>office supplies and polar water.</td>
</tr>
<tr>
<td>6002 Office Supplies</td>
<td>02.03.04,05,06,09</td>
</tr>
<tr>
<td>6003 Office Supplies</td>
<td>02.03.04,05,06,09</td>
</tr>
<tr>
<td>6004 Office Supplies</td>
<td>02.03.04,05,06,09</td>
</tr>
<tr>
<td>6005 Office Supplies</td>
<td>02.03.04,05,06,09</td>
</tr>
<tr>
<td>6010 Scientific &amp; Clinical Supplies</td>
<td>General scientific and clinical supplies from external sources</td>
</tr>
<tr>
<td></td>
<td>excluding chemicals, UPNCS Central Stores charges, gas cylinder</td>
</tr>
<tr>
<td></td>
<td>demurrage.</td>
</tr>
<tr>
<td></td>
<td>02.03.04,05,06,09</td>
</tr>
</tbody>
</table>

Partial List of Subcodes
Printer Profile

Set your Printer Profile

Select your printer as the default printer so that your PRISM reports will be directed to your printer rather than the system default printers.

1. Navigate to the Personal Profile Values window

Oracle Purchasing
N → Profile
Personal Profile Values

2. Press F11 from the keyboard to enter a query.

3. Enter Pri% in the Profile Name field.
   - Profile Name value is case-sensitive
**Printer Profile**

4. Press *Ctrl F11* from the keyboard to run the query.

5. Check the printer name in the **Default Value** field.
   - If this is NOT your printer, change it as follows . . .

6. Tab to the **User Value** field and click on the LOV icon.
**Printer Profile**

7. Notice that you see the list of all University prism printers.

8. Scroll through the list to find your printer by looking at the Name and/or Description fields.

9. Select your printer from this list.

10. Save the change.

   - Your printer should now be the designated printer for all PRISM reports except Print Custom PO. The designated printer for Print Custom PO is the PRISM Fax Server.